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1 Introduction 

Welcome to the JSQL (Java Version Query Tool) User's Guide. DBMaker is a 
powerful and flexible SQL Database Management System (DBMS) that supports an 

interactive Structured Query Language (SQL), a Microsoft Open Database 
Connectivity (ODBC) compatible interface, and Embedded SQL for C (ESQL/C). 
The unique open architecture and native ODBC interface adds the freedom to build 

custom applications using a wide variety of programming tools, or to query a database 
using ODBC compliant applications.  

JSQL is a graphical user interface (GUI) that hides the complexity of the DBMS and 

query language behind an intuitive, easy to understand, and convenient interface. It 
allows users to quickly manage and manipulate the database without the trouble of 
entering formal commands using SQL. 

This manual gives systematic instructions on how to use JSQL tool to log in to a 
database, to run an SQL query, and view query results by table mode or plain text 
mode. Users should have some SQL language knowledge before using JSQL.  

JSQL has a wide variety of features that enable users to effectively manage databases: 

 Run multiple query commands simultaneously 

 View query results by plain text mode/table mode 

 Load/save SQL commands 

 Execute by batch file 

 Multiple query results viewed for table mode 
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1.1 Additional Resources 

DBMaker provides a complete set of DBMS manuals in addition to this one. For 

more information on a particular subject, consult one of the books listed below: 

 For an introduction to DBMaker's capabilities and functions, refer to the 
DBMaker Tutorial. 

 For more information on designing, administering, and maintaining a 
DBMaker database, refer to the Database Administrator's Guide. 

 For more information on DBMaker management, refer to the JServer Manager 
User's Guide. 

 For more information on DBMaker configurations, refer to the Configuration 
Tool Reference. 

 For more information on DBMaker functions, refer to the DBA Tool User's 
Guide. 

 For more information on the dmSQL interface tool, refer to the dmSQL User's 
Guide. 

 For more information on the DCI COBOL Interface, refer to the DCI User's 
Guide. 

 For more information on the ESQL/C programming, refer to the ESQL/C 
User's Guide. 

 For more information on the native ODBC API and JDBC API, refer to the 

ODBC Programmer's Guide and JDBC Programmer's Guide. 

 For more information on error and warning messages, refer to the Error and 
Message Reference. 
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1.2 Technical Support 

CASEMaker provides thirty days of complimentary email and phone support during 
the evaluation period. When software is registered an additional thirty days of support 

is included. This extends the total support period for software to sixty days. However, 
CASEMaker continues to provide email support for any bugs reported after the 
complimentary support or registered support expires (free of charge).  

For most products, support is available beyond sixty days and may be purchased for 
twenty percent of the retail price of the product. Please contact sales@casemaker.com 
for details and prices.  

CASEMaker support contact information, by post mail, phone, or email, for your area 
is at: www.casemaker.com/support. We recommend searching the most current 
database of FAQ’s before contacting CASEMaker support staff. 

Please have the following information available when phoning support for a 
troubleshooting enquiry or include this information in your correspondence: 

 Product name and version number 

 Registration number 

 Registered customer name and address 

 Supplier/distributor where product was purchased 

 Platform and computer system configuration 

 Specific action(s) performed before error(s) occurred 

 Error message and number, if any 

 Any additional information deemed pertinent 
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1.3 Document Conventions 

This book uses a standard set of typographical conventions for clarity and ease of use. 
The NOTE, Procedure, Example, and Command Line conventions also have a second 

setting used with indentation.  
 

CONVENTION DESCRIPTION 
Italics 
 
 
 
 

Italics indicate placeholders for information that you must 
supply, such as user and table names. The word in italics is 
not typed, but replaced by the actual name. Italics also 
introduce new words, and occasionally for emphasis in text. 

Boldface 
 
 
 

Boldface indicates filenames, database names, table names, 
column names, user names, and other database schema 
objects. It is also used to emphasize menu commands in 
procedural steps. 

KEYWORDS 
 

All keywords used by the SQL language appear in uppercase 
when used in normal paragraph text. 

SMALL CAPS 
 
 
 

Small capital letters indicate keys on the keyboard. A plus sign 
(+) between two key names indicates to hold down the first 
key while pressing the second. A comma (,) between two key 
names indicates to release the first key before pressing the 
second key. 

NOTE Contains important information. 
 Procedure 

 
 

Indicates that procedural steps or sequential items will follow. 
Many tasks are described using this format to provide a logical 
sequence of steps for the user to follow.  

 Example 
 
 

Examples are given to clarify descriptions, and commonly 
include text, as it will appear on the screen. Other forms of 
this convention include Prototype and Syntax.  

Command Line 
 
 

Indicates text, as it should appear on a text-delimited screen. 
This format is commonly used to show input and output for 
dmSQL commands or the content in the dmconfig.ini file. 

Table 1-1Document Conventions 
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2 JSQL Basics 

This chapter introduces the layout of the JSQL Workspace and contains general 
information its components. 

2.1 JSQL Workspace 

The following graphic displays the important features of the Workspace. Users can 
input SQL query commands in the Command Entry Area, and view the results in the 
Command Result Area. The Command Result Area supports two formats, plain text 

mode and table mode. Use the tabbed panel to control the result format. This tool 
uses dmSQL, but does not support loading/unloading of host variables. 
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Figure 2-1: JSQL Tool Workspace 

Title Bar 

The title bar displays the program name “JSQL” and the Minimize, Maximize, and 
Close buttons. 

Menu Bar 

The menu bar displays JSQL’s pull-down menus. Each menu contains a list of related 

commands. 
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Toolbar 

The toolbar is a palette of command buttons and drop-down list boxes for many 
commonly used functions. 

Command Entry Area 

The Command Entry Area is the main window in the JSQL Workspace.You can use 

the Command Entry Area to enter commands.  

You can input more than one command to execute, but separate each command with 
a semicolon. You can also input or load from external files to the command window. 

Press F5 or click RUN button to execute multiple SQL commands. 

For more information on the SQL language used in JSQL, refer to the SQL command 
and function references. 

Command Result Area 

The results display as a plain text (like dmSQL tool), or a table below the command 
window When exectute queries. 

Whether or not the command executes successly, the success or error message should 

displays in result area.  

 Example: 

1. Enter a command into the Command Entry Area. For example: 

Select * from student; 

2. Press F5 or click the Run button ( ) to execute the SQL command. Separate 
multiple commands with a semicolon. The query results display in the 
Command Result Area. 

3. Press F4 or click the Clear button ( ) to cancel the command. 

©Copyright 1995-2017 CASEMaker Inc. 2-3
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NOTE Selecting the check box next to Show query result table from the Option menu. The 

SQL command executing results will show at table mode. 
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4. Use the up and down arrows to adjust record’s order or view the remaining 
records in table when viewing a large number of records.  

5. Click the Save table button to save the request result into an external file. A 
Save dialog box appears. 

 
6. Enter a name and location for the file in the dialog box. 

7. Click Save. 

Status Bar 

The status bar describes the current activity in the Workspace and displays the total 

time to execute commands. 
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3 Using JSQL 

This chapter describes JSQL functions, including: 

 Run multiple query commands simultaneously 

 View query results by plain text mode/table mode 

 Load/save SQL commands 

 Execute by batch file 

 Multiple query results viewed for table mode 

The menu bar contains the following, it has login, connect, disconnect, file, exit, save, 
load, run, execute, execute batch, option, preference option. 

The tool bar part of the JSQL tool allows you to run commands, save commands, load 
commands, and clear commands. 
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3.1 Database Login 

This section provides instructions for connecting and disconnecting from databases. 

Connecting to a Database 

Connect to any single-user database on a local computer or a client/server database 
running on a remote computer. 

 To connect to a database: 

1. Select Connect DataBase from the Login menu.  
 

 

2. The Connect dialog box appears. 

  

3. Select a database from the Database menu in the JSQL tool login window. 
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N

4. Enter you user ID in the User name field. 

OTE If a default user ID has already been set, then the default user ID automatically 

displays in the User Name field. 

5. If you require a password to connect to the database, enter it in the Password 
field. 

6. Click OK. The JSQL graphical user interface displays. 

  

Disconnecting from a Database 

Use the Menu command to disconnect from a single database. 

 To disconnect from a database: 

1. Select Disconnect from the Database menu. You disconnect from a database. 
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3.2 Files 

You can save SQL commands to an external file or load SQL commands into the 
command window from external file. 

Saving Commands 

You can save query result data into an external file. 

 To save SQL commands: 

1. Select Save Command from the File menu. The Save command dialog box 
displays. 

 

2. The Save command to field specifies the path to which command files are 
placed.  

3. You can identify a new location for the command file directory by entering a 

directory path in the field or by selecting a path using the browse button ( ).  

4. Selecting the browse button opens the Save as dialog box. 

©Copyright 1995-2017 CASEMaker Inc. 3-4 
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a) Enter a name and location for the file in the dialog box 

b) Click the Save as button. 

5. Choose an encoding method from the Choose encoding method drop down 
list. JSQL supports three encoding methods to save the command: Default, 
Unicode Little, or Unicode Big. 

6. Click OK. 

Loading Commands 

You can also load SQL commands into the command window from external files. 

 To load commands: 

1. Choose Load command from the File menu. The Open dialog appears. 

©Copyright 1995-2017 CASEMaker Inc. 3-5
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2. Select the location of the file from the Look in field. 

3. Click the Open button. A confirmation dialog box appears.  

 
4. Click OK. The load command appears in the SQL command entry area.  

5. Press F5 or click the Run button ( ) to execute the SQL command. 

3.3 Executing Commands 

You can use JSQL tool to run a batch file directly without loading the command. 

Execute SQL 

Use Execute SQL to execute SQL commands. You can perform the same by 
pushing F5 or clicking the Run button ( ). 
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Execute Batch 

You can run a batch file directly without load commands to the command window. 

  To execute batch commands: 

1. Select Execute Batch from the Run menu. The Choose Encoding of input file 
dialog box appears. 

 

2. Enter a directory for the input file in the Please select an input file field or by 

using the accompanying browse button ( ). 

3. Enter a directory for the result to save in the Please select an output file field 

or by using the browse button ( ).  

4. Select an encoding method from the Choose encoding method drop down list. 
Four methods are supported for encoding file: Default, Auto, Unicode Little, 
or Unicode Big. 

5. Click OK. The input command saves into the output file using the selected 
encoding method. 

©Copyright 1995-2017 CASEMaker Inc. 3-7
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3.4 Options 

JSQL Tool allows you to set preferences for the user interface. The following settings 

are available in the user preference window. 

Max history command: sets the number of history records to save in the database. 

Show query result table: the query result will show as table mode below command 

window. 

Max number of Records: sets the number of records to retrieve from a table at one 
time when viewing a large number of records. 

Preference 

Preferences include the number of max history commands, show query result table, 
max number of records option. 

 Preference 

1. Select Preference from the Option menu on the menu bar. 

 

2. The Setup Preference window will appear with the General page displayed. 

©Copyright 1995-2017 CASEMaker Inc. 3-8 



 

3. To change the Max history command, click the field and enter a new value, or 
using the upward and downward arrow to adjust the value. 

4. Selecting the check box next to Show query result table. A check mark in the 
box indicates the query result will show as table mode.  

5. Clicking the Table tab in the Setup Preference window opens the Table page. 

 

6. To change the Max number of Records, click the field and enter a new value, 
or using the upward and downward arrow to adjust the value. 

7. Click OK. 
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4 Menu Items and 
Toolbar Reference 

This chapter describes the commands contained in JSQL's pull-down menus and 
toolbars. 
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4.1 Pull-Down Menu Commands 

This section describes each of the items in JSQL's pull-down menus. 
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MENU COMMAND DESCRIBE 

Login 

Connect DB 

Connect to a database on 
a local computer or a 
client/server on a remote 
computer. 

Disconnect DB 
Disconnects the current 
database session. 

Exit Exit JSQL. 

File 

Save command 
Save query result to an 
extern file. 

Load command 
 

Load SQL command into 
command window from 
external file. 

Run 

Execute SQL Execute SQL command. 

Execute Batch 

Run a batch file directly 
without load command at 
the plain command 
window. 

Option Preference 
Set preferences for the user 
interface. 

Help 

Help 
Call JSQL online-help 
manual. 

DBMaker Website 
Connect to DBMaker 
website. 

About 
Explain JSQL's general 
information. 

Table 4-1 JSQL pull down menu 
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4.2 Toolbar Commands 

Several commonly used commands are also available as buttons and drop-down list 

boxes in the JSQL toolbar. 

The following table lists the icons appear in the JSQL tool’s toolbar.  

ICON DESCRIBE 

 
Run SQL Command 
Shortcut key: F5 

 Save Command 

 Load Command 

 
Clear Command 
Shortcut key: F4 

Table 4-2 Query Toolbar icons list 
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